acly-to-print
layouts

10,000

cliparts

1,400

photos

300

fonts
1,000
quotes

and
so much
more. ..
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Introduction

Installing Print Artist

To install Print Artist on your system:

For Windows 3.1 or 3.11, Print Artist muse be installed from the Windows Program Manager,
For Windows 93, use the Start button on the rask bar.

nsere the Prine Arcist CD into your CD-ROM drive.

For Windows 3.1 or 3.11, select Run from the file menu of the Program Manager. (Windows
95 will auromarically ask you vo run the install program when CD is inserced. Please re
your Windows 95 manual if you wish to disable the Autorun feacure.)

Af your CD-ROM drive is D, type "D:SETUPF” in the Command Line of che Run dialog box.
If your CD-ROM drive is some orher drive, use that lecter instead of D",

AT you have never insralled a Sierra product before, click on the install button to begin the
process of testing your system to see if ir meers the minimum system requirements for

Print Aruise.

L

15 these requivements, the instaliation program will offer an
initial dvive and parh for Print Artist and the opportunity tv change them. We vecommend you install
Print Avtise to the defeanit drive and path.

vlene wReely oy exi

Please Note: If yosr .

5. When you are satistied witch che initizl drive and path, click Conrtinue to stare the installation.

Special Nore:

Angrer the questions as they appear in the installation dialog boxes, A progress bar will display the
installation process. The program will alse ask what installation aption you prefer; Small, Medtum or
Large. With a Smali or Medinm installation, less havd dvive space is wsed and not all of Print Arcist's
pictuve filer ave loaded on your computer. If you choose either of these options you wusse insere the CD before
starting the prograw. A large insiallation will load all the Filer and it won't pe necessary vo wie the CD.

6. When installarion is complere, the program will return to the Program Manager. Exit from
Starrup and then Prine Artist is ready to run.




Font Installation

During Princ Artist’s installacion che program will ask you to select a Small, Medium or Large
Font installation. A Small Font inseallacion will load 22 fonts, a Medium Font installation
includes 150 fones and a Large Font installarion loads all 300 fonts.

Special Note: The greater numiber of forts installed on your system increases the amotend o “time it tabei to
& J ¥ ¥
start Windows.

Please Mote:
Instaliation witl take « lirtle while, 5o thit is @ great time to fill vat the vegistration card, your ticket to:
e A FREE one-year subscriprion to Sierra’s InterAction magazine, filled with informarion about
Sierra products and fun contests.
s Technical Supporr.
o Informartional mailings on Sierra’s latest products. {Remember you can also
register eleceronically.)

To run Print Artist:

Once ic’s installed, Princ Arcist is ready to ran.

1. Start from Windows.

2. For a Small or Medium installation insert the Prine Artist CD in che CD-ROM drive.

3. Double-click on che Print Artist icon in the Sierra Group or for Win 95 click on the Stare
burton, Programs and select Print Artist from the Sierra Program group.

Welcome to the Graphic World of Print Artist

Print Arcist is the ideal creative ool for every home and business. Ir allows you and your family
o instantly and easily create and produce professional-looking projects every time. Wherher it's
4 car wash banner for the Scouts or a Certificate of Distinction for work well done, make every
occasion meaningful, fun and special with Print Arrist,

Print Arcise will help you design and print a wide specerum of projects including:

e Signs e Cercificares e Banners

e Starionery o Greering cards e Calendars
Lerterheads 1/2 Fold Cards Monthly
Business Cards 1/4 Fold Cards Yearly
Envelopes o Crafrs
Postcards e Labels

and almost anyching else you can image that will print on a piece of paper.




SELECT DOCUMENTIYFE ™ 7770 Select your project from
; the Selece Docwment
Type diaiag hox.

] )

1/2 fold Cards

In addicion to 1/4 fold cards, Print Arcist now offers you the oprion of creating 1/2 fold cards.
Simply click on cards in the Select Document Type Screen. Nexr click on 1/2 cards and pick the
folding oprion that works best for the type of card you need.

About This Guide

Print Arrist is so easy to use, the best way to learn the program is ro simply open ir and srart
designing. The program dialog boxes display the basic commands for available options and the
document workspace gives you easy access to all the commands you need to create documents
and manage your files.

* Please Nove: Additional changes made after this manual’s publication way be fond in the
Reated Me infovmetion. .

Windows Questions
Instructions for installing and using Windows do not appear in rhis manual. Please review your
Microsolt Windows @ User's Guide for further inscructions.

On-Line Help

No maccer where you are in the program, Print Artise’s On-Line Help is cnly a butron away.
To access the On-Line Help, choose the Help command or, the Help button in a dialog box or,
press F1 anyrime, We suggest you browse or scroll through Print Arcist’s help topics o ger
famili

- with the program. Select a topic, click its name or press enrer.

Technical Support
Contact §

ra On-Line Technical Support if you have any problem wich the inscallation of Princ
Artist or if you experience difficulties with the program due to incompatibility or Windows
error messages. Sierra On-Line Technical Suppore provides as
VETLICS,

tance through a number of

#Please Nore: Faxing or using o wodem to send questions o Technical Support is often the fastest ways to
rvesolve a problent.

Before calling Sierra On-Line's Technical Support please read the Troubleshooting Tips on page
51 of this manual, and access the READ ME file included on the Print Arcise CD for a lisc of
crouble-shooting tips.

¥ Before contacting Sierva Ou-Line’s Technival Support vepavding printing problens, coniact your frinter
F}#du!{ﬂh'{!ﬁ'&)’ j?:r’ the latest dvivers.




Desktop

Print Artist 4.0 Desktop Environment

Instead of using 2 picce of paper or an easel within Print Artist, you'll use your monitor to
create and modify your projects. This is known as the desktop environment. Here we will show
and briefly explain the major components of the Print Artist environment.

o Deskrop/Workspace Area:
This is your work area where you'll design and edit your projects.

L]

Pull-Down Menus Bars:
These allow specific functions to creare your design.

Active graphic or object:
This shows you your current location on the screen.
e Scroll Bars:
These let you move your document around on the desktop up and down, side ro side.
® Status Line:
Left side indicares name of active graphic or object. The righr side indicates dimensions of
the object and how much it is rotated and skewed.

Toolbar
Provides sharrcuts to commonly-used commands.

4.0
Desktop Environment

Pring Arvtis

Toolbar
Ruler
dialog box.

Active graphic ar abject

Workspace

Scroll bars

For Mo preen i

. Status line
Choosing Commands from Menus

You can choose menu commands using either rhe mouse or the keyboard. Commands are
organized in menus above the desktop/workspace area.,

Using the Mouse
To open a menu using the mouse, click on the menu name using the left mouse burton.
When the menu drops down, click on the command you wanr.

Using the Keyboard
See the nexr page for & complete listing of keybeard shortcuts.




Keyboard Reference Chart

Accessing the dialog boxes with the keyboard is fast and casy with this handy chare. A dialog
box serves as an instruction guide ro help you through che various stages of your project,

Selecr Document Type dialog box

Under chese dialog boxes use the Tab key to move rhrough the document types as well as the
New, Open, Quir, and Help buttons. Onge you have highlighted your selecrion you can press
the Enrer or N key for New or the Spacebar or O key for Open.

Greeting Card Fold dialog box
Highlighr rhe OK button and use the arrow keys to selece a fold cype. The Tab key moves
through OK, Cancel and Help.

Far all sther dialsg boxer
The Tub key moves from one oprion or list to another in a specific dialog box. Arrow keys

moves through any list in chac box.

Use the Return or Enter keys to make a selection.

Wohen in o doceenent File Commeands

Activare menu har Alr key New Document Cerl+ N

Move across menu bar <+ and — Open Document Ctrl+O

File Menu Ale+F Save Ctrl+§

Edir Menu Ale+E Save As F12

View Menu Alc+V Print Cerl+P

Insert Menu Ale+1 Export Crel+E

Object Menu Ale1 O Exir Print Arcist Ale+F4

Fonr Menu Ale+IV

Effect Menu Ale+T Edlit Canmands

Color Menu Ale+C Undo Last Action Curl 7,

Shape Menu Alc+5 Curt Active Frame Crrl+ X

Alignment Menu Ale+ A Copy Active Frame Crel+C

Help Menu Ale+H Paste a Cur or

Maove through Opticns | and * Copied Frame Cerl+V
Delete Active Frame Delete

Tnsere Contmand Ingerc A Cut or

Insere Texc Cerl+T Copied Frame Insert

Insert Graphic Cerl+ G Duplicate Active Frame Cerl+D

Insert Fill Ctrl+F Edit Active Objecr Shift+Enter

Insert Background Crrl+B Select All Cerl+ A




Object Conimands

Bring Active Object Forward

Send Active Object Backward
Group Active Objects

Maximize

Ungroup Accive Object

Rartare Grouped Objects

Resize Grouped Objects

Zoom in on Point at Mouse Cursor
Show All

Zoom out on Point at Mouse Cursor

Help

TV,EK’H CL?F."E:‘J’SGK.’ZL?’_\'

Fir in Window
Zoom 100%

Zoom In

Zoom On Selection
Hide Selection
Show All

Redraw Now

Alr “+" on the number pad

Alt "-" on the number pad

Crerl+ Y

Crrl+ M

Crerl+U

Crel + — (Cerl+ + )

Crrl + T (Ceel+ L) .
Crel + Dbl click L. Burron

Cerla J

Crrl+Dbl. Click+Dbl. click R. Butron or
Shift + Crel+Dbl. click L. Button

El

Crrl+ W

Crrl+1

Ctrl "+7 on the number pad
Crrl “” on the number pad
Crrel+H

Crel+J

Crrl+R

The Toolbar

The Toolbar is your speedy access o text, graphics and effects. Accessing it is easy, just go to
the View menu and choose the Toolbar command and it will be displayed.

Each of the function buttons is simple, just click the appropriare burton with the mouse to use

the design funcrion you need for your project.




Document Type  Opens che Select Document Type dialog box.

New Opens The Select New...dialog box in the document type currently
open on the Deskrop.

- ' 1
Open Alloews you to open a previously saved document of the type currencly
open on the Deskeop.

Save Saves the current document.

,@1 Prine Opens che Prine Control Panel/Preview dialog box

ii‘?l Import Import graphics.

Texc Opens che Insere Texe dizlog box for text enery.

Graphic Opens che Inserr New Graphic dialog box for the insertion of graphics
into a document.

Fill Inserts a fill into a document.

?’8 Basic Shapes Opens the graphics dialog box with the Basics Shapes category
already open.

Displays che palecte of fonts available for use in Print Arcist.

Displays the palette of effects which may be applied o rexe, fill, basic
shapes, and symbols in Print Arrist.

Displays che Color palette,

Displays the palette of shapes which may be applied to frames in
Print Arrist,

@ Lefr align Aligns rexe in a selected text block o the left frame border.

@ Center align Centers lines of text in a selected texe block in its frame.

E Righe align Aligns rexe in a selected text block to the right frame border.
Word justify Justifies rext in a selecred texr block o rhe lefr and right borders

within a frame by adding or removing spaces between words.

Horizontal screcch “Strerches” a seleceed object between the left and righe borders of

its frame,

@ Vertical scretch “Stretches” a selected object to fill its frame berween the top and
bottom borders.

@] Word Wrap Toggles Word Wrap on and off.



Print Artist Basic Terms

Here are some of the most frequently used terms throughour rhe Prine Arrist program.
We've listed them so you can become familiar with them and better understand what you're

working with.

Active Frame

Clipboard

Color Palecre

Desktop

Dialog Box

Document

Document Type

Edit

Export

Fill

Font

Grab Handle

A frarne that has been selected indicating thar the next command
chosen will apply to it

A temnporary, invisible storage area in the program that retains the lasc
cur or copied object (or linked ser of objects) unril it’s pasted in
another document.

An area of the Customized Color dialog box that displays the colors
available for use in Print Artist. To open the dialog box, chose the

Custornize...command from the Color menu. Click on ir,

The screen background on which your decument appears. The Deskrop
funceions as a workrable.

A box that appears on vour screen when you choose a menu command
thar requires you to make an additienal choice.

Anything you create using Princ Arcist. It may include graphics, rext
ot a combination of both.

One of the ewelve kinds of documenrts you can creare with Prine Arcis

sign, banner, business card, calendar, craft, envelope, 1/4 greeting card,
letcerhead, posteard, cerrificate, label or 1/2 sized card.

Changes or modifies. Editing includes such actions as curring, pascing,
copying, resizing or applying colors and effects to objects.

Saving a docurnent in Print Arrisc in a file formar thae can be used in
another Suft“’ﬂrf_' progrim.

A full colored-in recrangle used ro fill in space in a document and to
set off graphics and text.

A complete set of characters, numbers, and symbols for a given
typeface.

A small box that appears in or on the edge of a frame, and indicates
thar a function will be activated by “grabbing” it with the mouse,



Graphic
Guideframe

Layout

Object

FPoine

Snap to Grid

Symbol

Template

Toggle
Text block

Zoom

An illustration from the Print Arcist's Graphic Library.

Empty frames in a template for the insertion of text blocks or graphics.

Fully formarted and designed, ready-to-print document included in
Print Arcist. 1,500 are available in Print Artisc.

Text block, fill, or graphic that has been inserted into & Prine Arcist
document.

A measure of type used by printers thac indicate the heighr of type on
a page.

A command that limits the movement of objects within a pre-defined,
invisible grid. This command allows you to wlign rwo or more frames
more precisely than just dropping cthem in.

A special kind of graphic to which effects can be applied.

A blank document with guideframes representing texc blocks and
graphics already laid out. A template gives a standard design solution
for common document types.

A command that turns on or off ancther command

A group of words or letters thar have been inserted in a document.

A way of changing how to view a document on screen. It can be seen
as magnified or reduced.



Seave your work from
the Save dialog box.

Saving A New Document

When vou are ready to save your document, you'll need to assign it two names a "descriptive
name” and a standard DOS “filename.”

A descriptive name will give you an idea of what the project is and can include up ro 32
characrers. Print Artist will show you an alphabetical list of all the documents you have creared
in char specific document type for example all che greeting cards you have creared for easy
preview and selection.

DOS filenames are used by the computer so it can properly store your saved projects on che
hard drive or a floppy disk. They can have a maximum of 8 letter characters and must not
coneain certain special number or symbol characters reserved for use by DOS.

Print Artist automarically assigns the following file exrensions ta the DOS filenames chat
vou choose:

e SGNN sign
e B business card
s CAL calendar

e CRF cralts

* ILTH letterhead
* ENV envelope

® BAN banner

e CER certificate
-
L]

PC postcard
.GC greeting card
*» LBL labels

- SAVEAS

CUFILE RLAME:
budlding.sgn o

i isign

| Ce = e

1. Choose the Save command from che file menu (or use the keyboard shorecur Crel + 8).

2. Type in a descriptive name of to 32 characters, and press Enrer.

2, Print Arcist will make up a DOS filename based on the descriptive name. Because this name
may conflict wich other documents, you can change it ro anything you wish, up ro
8 characrers.



o

. Decide on rhe drive and subdirectory in which ro save che document. Your Print Artist
subdirectory is che defaule storage directory if you do nothing at this point, Print Arcist will
use this subdirectory for scoring your document. If you want to change the storage location of
your file (say to floppy disk), follow chese steps:

. Click the arrow beside the Drives list to display a list of available drives.

. Select the desired drive from among those listed.

. Select the desired directory from che list.

a
b
¢. Click in the Directories list and use the arrows to move through those listed.
d
e. Conlirm your choice by clicking OK or pressing Enter.

SAVE AS

[LIST FILES OF TXP

Sign o)

E:

Saving An Existing Document and/or Renaming It

You can save an existing document just like you do a new one by typing in Cerl + S or choosing
Save from the File menu. This saves the document under the same descriptive name and
filename chac it had before.

Note: It & good idea to get in the habit of saving often (fust in case theve is a program or computer
Sailire). As you modify o profec, if you've not bappy wirh the changes then you can go back to your saved
vevsion and siavt again, But if you do have to vename your file, heve ave the steps to follme:

1. Choose che Save As...command from the File menu or press F12

The Save As dialog box will open, listing the document’s current names.
2. Highlighe the name you wish to change with your mouse.
3. Type the new name and click OK to confirm {or Press Enter).

Note: You it enter a new DOS filename to save the document ac a new docwnent. Changing
the dercriptive neme only will wor create o new file in your Prine Avtist subdivectory.

Sawve Ax dialog box
with dvive list open.




Open the Delere Files
dialog box o delete a
File.

Opening Saved Documents

To open a saved document from the Select Document Type dizlog box

Select rhe rype of document by clicking the appropriate burron,

. Click the Open button.

A dizlog box will oper: that lises all of your saved files by descriprive name.
.Highlight the descriptive name.

. Double-click the name, click OK or press Enter.

[ T

To open a saved document from the Workspace

1. Select Open from the File menu,

2. Highlight the descriptive name.

3. Double-click the name, click OK, or press Encer.

Deleting Saved Documents
1. Open the File menu and choose Delete Files.

~ DELETE FILES

Happy Birthday, Baby
‘Happy Birthday, Cake
‘Happy Fathers Day
 Happy Hallowsan
! Happy Holidays
Happy Mother's Day
- pHappy New Yaar

‘{ Happy Su Patick’s Day
| Happy Tha

LES OF TTPE:

] DE,LHE.} ; cl_osr § [ err |

This will open the Delere Tiles dialog box as shown. The Delete Files dialog box will
automatically open wirh any documents you have saved in che current document type box
(greeting cards) listed. If you wish to delete a file from another documenr type { 1.e. business
cards), click the down arrow nexe to the box displaying the current document type to drop
down a list of files by type. Then click to choose the desired documenr type.

If your document is stored on another drive, click the arrow to pull dewn the Drives list and
choose the correct drive, If they are stored in another directory, click the Direcrories list to
choose the correct one.

2. Click the descriptive name of the document you want to delete. It's shown in che
preview screen.
3. Click delete.

Exiting Print Artist

1. Return to the Print Artist Deskrap if you are not already there by pressing Isc.
2. 8ave your current document.

2. Choese Exit from the File menu.



Frames

Learning ro work wirth frames is cthe key to using Princ Arcist. All of the essential functions for
manipularing rexr and graphics are done with frames. Every object in a document is surrounded
by a frame (although you only see the frame when the object is selected). You cannot move,
reshape or edir the conrencs of a frame unless the frame is “aceive” or selected and visible on the

screen. Activate a frame by clicking somewhere within ic or press the Spacebar, which acrivares

one frame in your document. Nexe press Tab to activate each succeeding frame, one at a time.

Changes you meke to the frame affect everything within the frame in the same way, Only one
frame is active at a time, bur there are ways to link and group frames. No two objects can ever

l)(’(.’l.lp)" the same me(-!.

Frame Functions
The boxes that appear on the frame outline and in the center are “grab handles.” Bach grab
handle has a parcicular function. To move, resize, rotate, or skew an object, grab one of rhese
handles with the mouse and drag it. Releasing the mouse button completes the action.
e Skew grab handle

Corner resize grab handle —__

~ Verncal resize
grab handle

- Rotare grab handle

N

Horizontal resize grab handle —

Horizoneal res:ze
grab handle

Corner resize grab handle |

T Corner resize

Vertical resize grab handle
grab handle

Moving Function

This funcrion allows you to drag the active frame around the document and onto the Deskrop.
Nothing within the frame changes when you move it. If you want to move the frame on a
scraight horizontal or vertical path, press Shift while moving the frame. For best resulcs in this
case, grab the center handle of the frame by moving the cursor over the center handle. The
frame can be moved when the cursor changes to a hand.

Corner Resizing
This arrow lets you change the height and wideh of the frame. To keep rext, fills, and basic
shapes inserted from the Insert menn proportional, press Shift while resizing.

Vertical Resizing
This arrow lets you increase and decrease che height of che frame while keeping the widch

constant. Pressing Shilt while execuring this funcrion will conserain the change in frame height

o specific increments (8 points) on an invisible grid.




Horizontal Resizing

This arrow allows you to increase and decreasc the wideh of the frame while keeping irs height
constant. Pressing Shift while executing this funcrion will constrain the change in frame widrh
to 8 poinr increments on an invisible grid.

Resizing Around The Center

Print Arrist’s default is to resize around the “opposite handle” (the grab handle opposite the one
you are using for resizing). However, you have the option of resizing around the center of the
frame. Press the Alc key while resizing, or choose Resize Around Cenrer from the View menu.
This toggle comes in handy when you have centered an object on your document and want to
resize it withour having to recenter it when you're done.

Rotation

This function lecs you tilt the frame te any angle. The contents of the frame aren’t altered, only
their angle. The frame rotates around its center, not the center of rhe document. The handle in
the center of the frame shows rhe cenrer for the rotation for that frame. Pressing Shift while
execuring this function will constrain rotation to 13-degree increments.

Skewing
This funcrion lers you “bend” your text or graphic to the side. As with rotating, pressing Shift
while execuring this funcrion will constrain skew roration to 13-degree increments.

The effect of the skewing tool does nor preview on the screen, so you may make a change that
you didn't intend to do. If so use the Undo command on the Edir menu (Cerl + 2Z) immediacely
after skewing. This will allow you to manually return the skewed objecr to its original
orientation. The Revert command on the File menu rakes you back ro the last saved version of
the document you're currently working with and can also be used to correct unintended skews.

Note: Becanse Print Avtist keeps vhe proportions of your graphic consiant when you use the frane
Sfunctions, sametimes the frame is lavger then the rext block or graphic after you have verized, Yo can ke
the frane fit the object again by using the frame functions to thrink the frame size. If the bovder of the
frame extends off the screen, wse the View commands or the soroll bave on the vight and lower edpes of the
sevees 1o see then.

Snap to Grid and Precision Placement

Normally within Print Arcist you can slide your objects around as freely as you wanc. However,
when you rurn on Snap ro Grid (under the View menu), objects can only be moved in 1/8"
increments on an invisible grid, It's just as if you were aligning objects in your document with
the grid lines of graph paper, and were sliding a frame from one blue line to another. The
objects appear to “snap” into place along the grid lines.



Snap to Grid allows you o align two or more frames more precisely. Ie's very useful when
you are using a number of frames

and want them aligned on the same margin.

Deskeap with snap-to-
gric aption selected.

Snap to Grid is a toggle and can be turned on and off as needed.

Wire Frame Preview

This command (also a roggle on the View meru) shows all of the objecrs excepr the currently
active frame(s) as outlined frames only. These “wire frames” look the same on your screen as the
blank Guideframes in templates.

As you begin to work with more complex graphics using many layers and elements, you'll
appreciate the wire frame pre

ew. It significantly speeds up Print Arcist’s operation. Working
with Wire Frame Preview also lets you concentrare on the look and placement of a particular
frame without getting distracted by other the elements in your document, Using Wire Frame
Preview also allows you to work more easily wich small or hard-to-grab frames. Moving
berween frames is easy, just click or press Tab ro acrivate a new frame.

Left: Document with

wive frame preview

selecred,

Right: Th
AGcHNIENT

fearie
iirh wive
Sframe preview off

Working with overlapping frames
Many times your document can have a number of overlapping elements. Acrivating and
grabbing the righr frame can be a little confusing. Here are some hints to get you on your way.

Using the Wire Frame Preview is a good idea if you are having trouble grabbing and
manipulating the frames of & small cbject thac falls in the field of a larger one. Only the current
active frame handles are available, so you won't accidentally grab the wrong one.




efe: Linked "Parvty”
praphics

Right: Unlinked
“Party” graphics may
now be insevied
.I'.'ff.‘{ﬂi'rfdﬂ!‘.‘ﬂ(r’.lf}'.

Or use the Tab key to move rthrough the frames uncil you accivare che one you want. Then hold
down the Crrl key while manipulating the frame wich the mouse.

Linking and grouping functions
Print Artis
frames function. Linking frames allows you to perform the same command simultaneously on

t allows you to select and affect more than one frame at a time under che Linking

separate frames. The frames are still treated as separate objects and not as a group. Each frame
will seill rotate, skew and resize around its own center, not the cenrer of che linked frames.

There are & number of ways to link frames in Print Artisc

® Choose one of the four Select All commands from the Edic menu
® Press Shift while you click each object you want selected with che left mouse burron

e Draw a box around them (“marquee-selecr™). Imagine the size of a box that would include all
the objects. Posicion che pointer at one of the corners of this box and press the left mouse
button while dragging the poinrer dingonally across the screen. Drag until you have included
all the items in the box. The box needs to be big enough to include every pare of each frame
you want ro link, Once it's big enough, release che mouse button. You'll see outlined frames
on the screen.

Grouping frames

Grouping frames takes you one step further, the center of the group of linked frames becomes
the center. This allows you to resize and rorare groups of objects while maintaining their
relationship with one anocher,

The best way to understand the difference is to link a few frames and cry some commands. If
you rotate or skew linked frames, you can see how each frame is affecred separacely. To see the
difference between linked resizing and group resizing, we suggest you insert two objects and
duplicare each of them. Then link each sec of cwo. Resize one using the frame functions and
tesize the other using che group funcrions.

Note: Only one frame will bave sizable bandles when you link frames. This frame's center will be the
defanlt center for performing linked actions. Group actions ave performed around the calenlated center af
the group.
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Unlinking Frames
To unlink all frames at once, simply click once anywhere in your document (except within a
{rame) or on the Desktop. :

Linkage is 2 toggle, so to unlink frames selectively, use the same method you used to link them:

® Press Shift while you click once wich the left mouse butten on the frame(s) you want to
unlink.

e Click the frame{s) you want to unlink with the righrt bucron.

Importing Graphics from other documents

To import a graphic, vou must {irst have a document cpen. Open the File menu and select
Impore. A dialog box will open that allows you to browse through direcrories and specify che
format to import.

Importable formats are: Photo CD, JPEG, Metafile, TIFE, EPS, PCX and BMP.

Exporting to other documents

You musr first insert 2 graphic into a document in order to export it. To export a graphic, make
it active in a document, open the File menu and select Export.... A dialog box will open so you
can give the graphic a file name, and specify in what format you want the graphic exported.

Print Artist allows you to export files in the following formats: TIFF (tif.), bitmap (bmp.),
Encapsulated PostScript (.eps), and Windows Metafile {wmf).

Cutting and Pasting
Because the Cur and Paste funcrions are standard in Windows, you may also want to import

graphics and rexe from other Windows applicaticns.

Rulers

Sometimes you might find thar an on-screen ruler would be useful when working on a projecr.
I you want the reler showing on your screen (or if you would like to turn it off), go to the view
menu. Click on it to bring down the oprions and click on rhe ruler to turn it on or off.

Workipace with view

mense fist and vulers

highiighted,
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The Palettes arve your
creabivity foodi.

Palettes

[

At the top of the Desktop is the Main Menu title bar thac lists all the menus available to you
within rhe Deskrop. The choices within the menus are dark when available and gray when not.
If you open a blank documenr or remplare, most menu selections will be gray until you insert
an object.

The Font, Effect, Color and Shape menus offer many choices. Since there are too many to list in
a standard Windows menu, only

few of che choices appear when you first open these menus.
However they do offer you an oprion entitled More {(Palecce).at the end of the list. Choosing
More (Palette)... opens a palecce thae liscs all the choices available under that menu.

The Color, Effect, Font and Shape palettes are different from the other menus in Print Artist
because they can be dragged to any parr of the Desktop for quick reference at any time, If
moved away from the Toolbar, chey will remain open on-screen until you close them (by
double-clicking their control boxes or pushing their toggle buctons on the Toolbar). Unlike the
other menus, palectes have a scroll box where their many oprions are listed.

To maove a palecce, place the pointer in the title bar and hold down the left mouse burron
while dragging the palecte to che part of your screen where you wane it. Princ Arcisc saves your
palette placements (even when you exir rhe program), unless you rurn off the Save Paletce
Placements function on the View menu. To activare a palette left open on screen, click
anywhere in it

Palerres may be apened using the More...option from the corresponding menus, or by pushing
the butrons on the Toolbar, Palettes contain all che oprions availuble on the menus as well as
rhe added choices available in che lises.



-Graphics, Fills, Shapes and Symbols

Whae are they and how can they make your project look better? Graphics are fully crafted
illustrations, Fills are recrangles “filled in” with color. They are often used to set off texr and
praphics and to fill in white space in documents. Shapes arc basic geometric shapes “filled in”
with coler. They may be inserced from the Insert menu as well as the Graphics library. Symbols
ire representational shapes “filled in” with color, and include nation symbaols. They are found in
the Places category in the Graphics library.

The important difference becween graphics and fills, shapes and symbols within Princ Arcise is
thae fills, shapes and symbols are rreared much like texr. You can apply almost the full range of
Effect commuands to them, unlike graphics where you can only use the Flipped command,

Graphics

When inserting a graphic you can assign a new frame shape, twist che shape wirhin the frame,
change its alignment within a frame and change the color applied to its surfaces, bur you
cannoc actually edir anyrhing wirhin rhe frame.

When you choose a graphic, only a copy of Print Artists original is inserced, Nothing you do to
a graphic within a documenc affects the original.

Fill, Shape and Symbol Characteristics

All fills, shapes and symbols have four components (but enly some of them are visible when a
fill, shape or symbol in inserred):

e Face (the visible object for example an artow or circle).
® Tace outline Background outline
® Frame background

e Background outline

e Face outline
Frame background

— Face

All text blocks, plain fills, basic shapes and symbols are inserted with the frame background
outline, frame background and face oucline ser ro che color choice “cransparent.”

All fills, shapes, and symbaols have defanls insertion colors assigned to them. You can change
these colors by choosing a color from the Color menu or palecte, or by using the Customize
Color option. You can also apply colors individually to any [ill and symbol sections,
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Fills
Three commands insere fills direcely from the Insest menu. The Fill command inserts a solid-
colared square, which is the fill’s visible face. All ocher sections are transparent,

The Background Fill command inseres a fill sized o fit the document and automatically places
it behind other objects in the document.

The Frame command inserts a fill with the face set ro transparent and the face outline set tb

black.
Fills are invaluable for enhancing both graphics and texr, as well as filling in white space. They

often define a document’s look and using fills is one way to give visual structure to a document
withour detracting from the main graphic or texe blocks.

Fill with outline

—f— Ourline

Basic Shapes

This category contains simple geometric shapes like the circle and acragon. You can access this
category directly from the Insert menu, as well as the Graphics library. Selecting Bas:ic
Shape...from the Insert menu highlighes this category in the Select Graphic dialog box.

Note: Bavic Shapes insevied from the Insert mieni, or by pushing the Basic Shapes button the Toolbar, may
be vechaped with the vecizing function, When inserted from the Graphics library, they will not be distorted
when vesized wnless the Hovizontally Stretched or Vertically Stretohed comimand from the Alignment mens
By been selected,

Symbols
Symbols can be found in rwo caregories in the Graphics library. The symbols category contains
items like che recy

le symbal shown. Nartion symbols are found in the Places categories.
Like fills and basic shapes, symbals may have many of Print Artist’s effects applied to them.

a @ ® @
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Inserting Graphics, Fills, Shapes, and Symbols

Insert a new graphic

| Choose Graphic... from the Inserr menu, or press the Graphic burton on the Toolbar.

4. 5croll chrough the categories, or keywords, or type a graphics keyword until the desired
category is visible. Click the category to highlighr ic.

4. Scroll chrough che Graphics list using che scroll bar, Click che desired name to highlighe it
and display the graphic on the preview screen.

A, Double-click the preview screen or the ﬁigh]ig}]tf_:d name, or press Encer,

Replacing an existing graphic

I, Activate the frame around the unwanred graphic by clicking che frame, then double-click.
You will return to the point in che Graphics library where che original graphic came from.

2. If you want to replace the original graphic with one from the same category, use steps 3 and
4 from the previous list, If you want to replace the original graphic wirh one from a different
category, return to the Category list and choose the category you want and then follow steps
3 and 4.

Replacement graphics will be inserted at che same frame size and orientation as the original
graphic. Once you have inserced a graphic in a document, the graphic's category and ics
descriptive name will remain highlighred. The next time you look ar the Graphics Grabber, you
will see your previous selection on rhe preview screen (unless vou are working with a cemplace).

Show The Toolbar Buttons

Insert fills and basic shapes direcely into your document using the Fill and Basic Shape ‘
commands from che Insert menu or the Fill button or Basic Shape button on the Toolbar, You
can also insert basic shapes from the Graphics Grabber using the Graphic command from che
Insert menu.

Insertion Points for graphics, symbols and fills

Princ Artist automartically inserrs all graphics, symbols and fills in the horizontal and vertical
center of the Deskrop. This default cannot be changed. Remember, the center of the Deskiop is
not necessarily the same as the center of your documenr. If you wanr to inserr a new ohject in
another locacion, use the View commands or the Deskrop scroll bars to change the location of
the cenrer the Desktop and then insert your graphic or texe block.

Inserting backgrounds and borders

Backgrounds and borders can be inserced two ways. One, as you would other graphics, using
the Graphic command from the Insert menu. They will appear in che standard default frame
size. You can also insert them already sized to fit your entire document by using the special
Background graphic and Berder Graphic commands on the Insert menu.




Inierting a backgromnd

Enlavged background
boreer,

To insert a background or border at full document size:

Ouwr original graphic
crapped.

1. Open the Insert menu and choose the Background.. or Border. .command.

The Graphics Grabber automatically opens, with either the Background or the Border category
selecred.. Browse through o find the appropriate background or border.

2. Double-click the chosen background or border or click it once and press Enter.

Cropping Graphics on the Desktop

While you cannot edit anything wichin a graphic, you can position and resize graphics so
portions you don't want are “pushed off” your document and onto the Desktop. These
unwanted portions will be invisible on the screen and will not print, but they are still chere and
can be pulled back onto the page if you want them in your document again.

The layout on the left is an example. The original graphic was enlarged wich the frame grab
handles and then cthe Flipped command was used.

Duplicating

The Duplicate command on the Edit menu is very useful when working with graphics.
Duplicate makes a copy of the selected object and puts the copy on top so it overlaps but does
not cover the original document. This is a shortcut command, allowing for quick copying and
placement of objects you want to repeat in your document. You can still resize and reposition
all of the objecrs as you like, using the frame grab handles.



T'he example here shows a possibility of the Duplicate command.

Using the duplicare
commmeand to create a

design.
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Overlaying objects (Object menu}
Many layouts in Print Arcist consist of carefully arranged overlays of graphics, symbols, shapes,
{ills and text blocks. Fills and shapes are often behind all che other elements to give a documenr

i visual coherence and unity.

The Bring to Front, Send to Back, Forward and Send Backward commands on the Object menu
are designed to help contrel the overlay of abjects in your document.

The Send ro Back command rakes the selected object and places it behind all octher objects in
the document.

The abfect mewi.

The Bring To Front command takes che selected object and places it in front of all other objecrs

in a docume

Left: Notice the tviangle
is bebind the £)e.

Righe: Using the Bring
Fa

frfzmgfe i gt i _,".".rn.r.'

af the eye,

vatvd comzmand the

The Bring Forward (Alc + Grey Plus n} and Send Backward (Ale+ Grey Minus sign)
commands are usetul when you have several levels of objects placed on a document. (The “grev”
mathematical signs are those on the keypad.) These commands move the selected object forward
or backward one level as shown here.

2’5 easy to sse the Send

Backwward consmen




A devipn with different
shapres,

Levels of objects in Print Artist are defined by the order in which the objects are originally
placed on che document. If you use the Send Backward command, and it does not produce the
expected resules, it is probably because the objects you are erying to affect were acrually placed
several levels apart from one another,

Note: If yor ever “lose” an object while wsing ihese commands, it's probably eovered by a larger object in
¥ 7 £ ) 4 o il
front. Selece the {arger object and wse Send to Back put it in the background: then the smaller abject will

appear again, The Hide Selection command can alio help in this situation.

Using Shapes (Shape menu and palette)
You can change the look of graphics in two main ways: by recoloring or reshaping them.

The Shape commands offer two sets of choices. One set gives you a choice of three basic frame
shapes, Recrangular, Clockwise Arc, and CounrerClockwise Arc (COW), while rhe arher set
contains choices which allow you ro distort the conteats of che frame.

FESTIVITIES BEGIN

GrreeT, Vownown. For
MORE INFO. CALL
555-212- 8939

ThesuTon Suow - Carnese CosTunes

The best way to see what these options can do is to simply try them. In addition, the layout
above shows vou some of what the shape commands can do.

Document Templates

Templates can help you get started with a project. Bach template is already formarred with
“Guideframes” sized and placed so you can quickly creare a well-designed document. The
empry rectangles represent texe blocks, the rectangles crosscut with an "X represent graphics,



Il you have never designed a document before, using a remplare is a quick and easy way to learn
some of the basics of good design. Looking ar the relative placement and sizing of text and
Jtaphics Guideframes can start you thinking about what makes good layour.

A docwment template.

The templates included in each document rype vary a grear deal. The descriptive names are
meant only to suggest che most likely use tor the templarte.

You open a remplare in the same way you open a layout or a blank: Select the desired template,
ind double-click it or press Enter, If you double-click a graphics Guideframe, the Graphics
library will open, if you double-click a rext Guideframe, the Change text dialog box will open.

If you enter text aned graphics in this way, anyrhing you insert will automatically be sized ro fic
into the Guidetrame. This is one of the advantages to using a template, you don’t have to
reposition or resize your objecrs.

You are not bound by the layout given to you in a template. The texc and graphic blocks
defined for you are merely guides. You can delete the empry guideframes just as you delece any
object, and you can move and resize inserted rext blocks and graphics in any way.

A docrment !e.wpfs.f.{e
with grapbice insevted.

Marianne Beckerman

Department Manager

Eastside Gift Shop - 555 Main Street - Fortworth, Texas 97555




Zoom

Using View Commands (View Menu)

View commands change your view of the document on the screen. When Advanced Menus is
checked on rhe View menu, you have access to all of the advanced functions and commands of
Print Arcist.

There are four major situarions in which yvou would wanr to use the View Commands:

e Working wich small graphics or rext blocks. Close views (Zoom In and Zoom On Selection)

enable you to position and size objects more precisely.

e Working on document and layour design. Distant views (Zoom Our, Zoom 1009 for smaller
documents, and Fit in Window) enable you to better evaluate spatial relations between
objecrs and rhe overall shape of their design,

o Working with frames chac cravel off the page of your document. Distant views (Zoom Out)
lets you see and grab frame handles more easily.

* Working with very large documents like banners or muldi-page signs. Closer views {(Zoom
100% and Zoom In) allow you to see the final the printed document

The following commands are all on the View menu

Fit in Window (Cerl + W) Zoom 100% (Cerl + 1)

Zoom Out (Crrel + Grey Minus sign)

sH (Cerl + Q)




Moving Elements between Documents

With Princ Artist you can use the Clipboard and Edit commands to move and copy elements
[rom one document to another. This way you can‘create matching documents more easily. For
pxumple, you could creare 2 matching letterhead and envelope set by copying and pasting a
pustomized graphic from the lecterhead to the envelope.

b copy an object or linked set of objects from one document to another:

| Select or link the objects to be copied

2 Choose Copy from the Edit menu or press Cerl + C

4 Open the document you're placing the object in. Depending on the type of document you
want to create, this may require returning to the Select Document Type dialog box, choosing
# new document type, and then opening a document.

4. Choose Paste from the Edit menu or press Crrl + V.

That's it. The copied object should now appear. If it’s not exaccly where you want it in the new
document, move it as you would any ather objecr.

You can cut an object from one document and pasee it into another by following che same
tommands, using cur (Cerl + X)) instead of the Copy command.

Scanning

Select Source

This optional is located under the file menu. It allows you to selecr the scanner software
installed on your system. Print Artist will search che system and find any software thar is 100%
Twain comparible.

Acquire

Acquire is located in the File menu. After you have selected your scanner software in Selecs
Source, you'll need to acquire it. Your scanner software takes over and should prompc you to
begin scanning after you have made your selections.

Text
[nserting and man:pulating texe is casy. First inserr the texe and chen apply effects and colors. The Acquive conmicnd
You can resize, reshape and recolor rext in any way vou like, iv bighlighted ar shown

-'{?8'?‘6'.
The frame is the real border of a text block. Each texr block contains:

® Face

e Face Outline

® Frame background
® Background outline

The face is the visual parr of the lecter or numeral. You won't see the background and outlines
when you first insert text, because the defaule color for boch background and curlines is
LEAnSparent.
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Face outline
Face

Frame background

Background cutline

Tnsert Text diafog box.

When rext is first inserted, it will always be:

e Plain Claren fon style. You can change this by choosing a new font from the Font menu or
palette:

e 100% width. The normal width for the fonr. Change text width by using the Widch
command on che Fonr menu.

e Recrangle frame and shape. .

e Horizoneal orientation.

All of these defaulr characreristics can be changed at any time.

Inserted text is always black until you change it. Text added to an existing rext block will
automarically be assigned the colors of the existing text. To change the color of text, use the
Color menu, palette or Customize Color Oprtion.

Inserting Text
1. Choose Text...from the Insert menu, or push the Texe Insercion button on the Toolbar.

 INSSERT NEW TEXT

o o P ERTER TEXT:
[SIERRA DN.LINE
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2. Type in the texe, including whatever special characters you may want.
3. Click OK on the Change Texr or Insert Text dialog boxes to end your text encry session.
4. When you finish entering rext, click OK or press Crrl + Lnter.

Special Note: Push Quote burron to access over 1,000 quotes.



Bditing Text

Tt edic an e

dsting rexe block

I Activate its frame and double-click the frame or choose the Bdir Texr...command from che
Belic menu,

4 Make the changes to che texe,

w1 you wane to delere parts of the texr, highlight che section with the mouse and press Del,

Iy, To add rexr to the existing rext block, position the cursor ac the appropriare place and type in
Hew texe. '

4 Press Cerl + Enter. You will now see your text changes.

Six ways to change the appearance of Print Arcist text:

® Change fonc

® Change type style

# Change shape

# Change rhe text alignment
® Change the color

® Apply effects

Typefaces
“Typeface’

refers to the shape or outline of letters, numbers or other printed symbols,

The same mevrage in

cfeves.

three different £y,

T GHPE SHERES
LOUVERYILLE, BR 53990
9585550001

Point Size

"Point size” refers to the heighr of type on the page. A “point” equals about 1/72 of an inch.

Fonts

QR o ST

LeUVERYICLe, S0 TTTET

EEF-FEE- B8

1 CARE SRORES
LATRERVILLE, 5 1ORID
335858 -0001

A font is a complete alphabet for a given typeface. The words type and fonr are often used

interchangeably. Princ Artisc conrains 300 fonts. Fonts have a big impacr on your project

design. Some are very professional looking while others are more whimsical and fun. Picking

the correct one for your design is importane. Ses Design suggestions on page 41,

W
=



‘The Font Palette wenu.

Type Style .

Type style refers to the orientation of your type with reference o an imaginary horizontal frame
across a page. Plain type, the default style in Print Arcist, is vertically upright and ar nermal
wideh for thac typeface. In italic scyle, the letters are all slanced to che right, while boldface is
heavier and darker.

Choose type styles and fonts from the Font palette. To open the Fons palerte, choose More. ..
from the Font menu or push the Fonr burten on the Toolbar. Preview fonts by scrolling
through the choices. Each will preview in the currently selected rype style.

Choose fones and rype styles by clicking your cheice from the Font palerce.

FONTS

£t

i L beghit
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Paris

Sizing text
Prine Arcist inserts texe to fit the default texe insertion frame, which is always the same size on
the screen. Use the frame grab handles to resize and reposition a rext block.

Using frame handles to resize text:
1. Move the pointer until the icon for che funcrion you want to use ap
2. Drag the frame uneil it has reached che size you want.

3. Release the mouse button.

Print Artist will then make rhe best possible {it. Because the proportions are kept constant,
sometimes your text may no longer fill the frame afrer resiz

Specifying point size using the Font menu
To specify the point size of a text block:

—_

. Click on the radio button nexr to ©
become highlighred.
. Change the point size by:

frame to letter.” The numbers indicating point size

b

a. Clicking the scroll arrows to increase or decrease the point size, or
L. Typing in the new point size,




Note: If you bave set a point size and later try fo vesize the frame wsing ihe frame bandies, the beight of
the frame will “snap back”

t6 yoir specified point size, You musest change the frame's width, The skewing,
Votation and moving bandles wan't be affected. To trevn on the vertical vesize bandler again, re-enier the

Selvct Point Size dialog box and selece Fit letter to Frame

POINT SIZE Ty Change fetter point size
with the Select Poing
size dialog box,

Gk x
Paint size is tha |
distance from the |
owest descender |
the top of the |
ascander. (1 peint |
FT2 ineh) i

Changing text width

|. Select the rexe block and then chose Widrh., from the Font menu. A Select Fone Width
dialog box appears.

a. Click the scroll arrows which will increase or decrease the text widdh seteing, or

b. Type the desired width.

Aligning Text [i!

Text alignment refers to the placement of text in the frame; centered, flush with the right or
left edge of the frame, justified, running verrically down che page, ecc. When vou first insert
text in Print Ar
Word Wrap on. Choos

frame.

t, it is placed horizoneally and vertically centered in che text frame, with

commands from che Alignment menu to change alignment within the

Note: The commands on the Alipnment menn vefer to alignment of an ehject within the frame only, nst o

aligrment within the docement.

To change the alignment of the encire frame wichin the document, use the frame handles.

Word Wrap ]

Word Wrap is a roggle command under che Alignment menu. Turn it on by choosing Word
Wrap from the menu or clicking the Word Wrap button on the Toolbar. Turned on, Word
Wrap automatically moves text to the nexc line when it comes o the right edge of rhe frame.
When Word Wrap is tu
vertical center of che frame.

o of

L all of the text in a block will be placed on ane line, in the




Text repositioned under
the vertical command,

Vertical text

To create vertical texe (right-side-up letrers running vertically up and down the page), first
insert texe in the usual way, and then choose the Vertical command from the Alignment menu.
Your text will then be repositioned. The maximum number of characters for the vertical

rext is 225,
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Justifying text

Justified rexr means all lines of che texr are flush with the specified margins. You can choose
“letter-justified” rext (which evenly spaces all che lerrers across the frame) or “word-justified”
text (this adds ro the spacing berween words to make the line flush wich the left and righe
margins). These functions will be influenced if the Word Wrap function is on or not. The
Vertical Justified command will arrange the lines in a texe block so it's flushed wich the top and
bottom margins of the frame.

Other Spacing Commands

Lefe Aligns the text to the left frame border,

Horizonrally Cenrered  Places the text in che horizontal cencer of the frame.

Right Aligns the texe to the right frame border.

Horizonrally Stretched  Srretches each lecter so the text is horizontally framed, which resules
in some distortion and thickens the original fonr.

Top Aligns the text with the top frame border,

Vertically Cenrered Places che texc in the vertical center of the frame.



Hartom
Vertically Seretched
It leteer spacing

Wxtra line spacing

Shaping Text

Aligns the text with the bottom frame border.
Seretches all the letters in the verdical direction.
Adds extra spaces berween each lecter in a selecred rexr block.

Increases the space berween each line in a
selecred rext block.
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The Shape command offers three frame shape choices: Rectangle (the defaule serring), Clockwise
Are and Counterclockwise (COW) Arc. The Arc commands twist and reshape the frame

contents. Select the commands from the lower portion of the menu or from the list portion of

the paletre.

Print

When vou choose the Print command from cthe File menu, the Print Conrrol Panel/Preview
dinlog box opens, as shown below. The document you want to print will display oriented just as
it will appear on the printed page. Pink lines crossing rhe tmage indicates thae the document
will printout on more than one page.

Special Note: [F vaw bave a color mionitor bud arve pristing on a monochyone printer, any oolor inge in
S ! £ ) £

the Print Preview screen will appear in colov, even though it will be printed in monochrome.

Diiffevent spacing

CORR I .rlCl'{\',



Print Setup
Select yoser printing PRIMT SETUP
chafces from this dialog i :
e gl : DR
AR L D Prlar : - |
{eumentiy HE Desket (BO0C ¢alarBmart ap LPTY:) &
i Ml Byl !
 [HP Bkt WGEC Cuni S et e LATT- a0 .
You'll find this oprion very similar to vour Windows Printer Serup. On this screen you choose
the default printer or selece an alternative princer from the specific srincer pull down menu.
The paper orientation can be set to porerait (vertical) or landscape (harizantal), and the desired
paper size and source are also setup in chis screen.
The Options buccon will list the different printer oprions available on your prineer driver, Every
printer driver has different options, so you'll need ro consult your printer manual for more
information.
Print Options
Print Oprion dialog L PRINT QPTIONS
b, b
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Coloring Book
When you select this option only an cutline of your text and graphics are princed.

Mirror Image

This option prints the mirror image of the selected document on the Prine Control
Panel/Preview screen. This command is auromatically curned off again once you leave the prine
dialog screen.
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§ small images (such as business cards) on the page so you can print multiples of a single
o maximize print curput. The number of tiled images is dependent on the image size.

.

[hin Outlines )

. ally when drawing a line or outline, Print Arcist will draw a line whaose thickness is
rtional to the rest of che graphic or object. However, this means that on devices such as
15, a line is drawn repeatedly and offset a lictle cach time. This option ensures chat lines
Irawn only once regardless of cheir thickness.

' Crop Marks
§ you to print crop marks for business cards and postcards.

gins

sectings decermine how a document is laid out on the page. Symmetrically ser che
rizontal marging ro rhe same value and the verrical margins ro che same value. Values used
the larger of the two. This is the optimal seteing for greeting cards. Minimal will print as

¢ an image on a page as possihle. All printing is done o the limirs ser in che Printable Area
v boxes. Equal sets all four margins ro the largest of the four values in the offser boxes. This
on has cthe smallest available printing area. =

tion
se secrings will determine whether or not your document is rotated on the page. It

matically will keep the document ac 1009 size on the fewest number of pages. Tt will
te the document, if addictional pages are not required.

te: Envelupes are the exception to this rale.

"Never” prevents your decument from being rotated. “Always” rotates the document while
inting. All rotating seteings are saved wich the document.




Design Suggestions

Simple Design Suggestions or Graphic Design 101

Creating projects in Print Artisc is a wonderful way to communicare ro friends and neighbors,

as well as ro develop and showease your own creative energy and ralent. There are no real rules

for designing these projects, bur there are guidelines that you can keep in mind to ensure that

your layour receives the kind of arrenrion it needs to communicate your message effectively.

Make The Most Of Your Message.
Before beginning your project, think about your audience and the kind of message vou are

trying to convey. Consider the appropriateness of the graphics images, color palecte and the

overall “feel” you intend to communicate. Simpler is better; the less information clustered

togecher on a page, the more

dappoar.

rect and more powerful the images char you have selected will

Consider Composition Carefully.
The artistic arrangement of objects and words on o page will ger your message across, and make
you look good at the same time. Organizing your layour around one dominant element will

most successfully communicare your message, A clurcered layour s not inv

RLFls to the rea

Balance.
It brings harmony and propartion ro your design, For example, too many objects at the top of
your page will make it look “heavy.” Look ar your work from a distance, and give it the “squinc

test” If it looks unbalanced when you squine ac it, make a few changes and squine again.

Scale.
Try not to have too many objects or lines of type that are equal in size or prominence, Decide
on your most important graphic, word or color, and lec it speak the loudest.

White Space.

While not necessarily always white, it is imporrant to give your eye some

full of words or pictures. Goad use of whire space will make people want to read more. White

space provides a background that emphasizes whatever it surrcunds, and will focus che reader's

ge.

ACTETITION O your mes

Use of color.

There are many ways you can use color to give your work pizeaze, For a banner, gar

sign, announcement or (lyer, choose colors thar ger noriced from a distance; for example, black

rype against a yellow background, or white type against red. For an invitation, however, you

may want to cheose colors that are in cthe same fumily to creare @ more subrle message, Choose
colors thae reflect the message you are sending. Brighe colors indicate excitement, while
i 't when

subdued colors lend o sophisticared look. Remember, less is more; color ga

used selectively.




Hondability.

Nimply put, anything that is difficult to read will simply not be read. Use Print Artist’s
Hictedible type special effeces or a larger type size to emphasize important ideas or for

Wit rgeous headlines, but make your text as easy on the eves as possible. Or, use a larger type
Mee to emphasize importanc ideas, and a smaller texe for the body copy.

Hyws path.

Anuther pare of readability. If your sign is too jumbled with graphics or text, your reader may
Jet confused and lose interest in what you have to say. Imagine your readers navigating from
wie headline or image o the next, Can they find their way easily?

IFy new papers for a special look.

I periment, experiment, experiment! You can find a huge variety of special paper colors and
fextures ac your local paper store. Try them out, and you may be very surprised at the difference
Yol see, A brown paper bag can make a letterhead look earthy and serious, while a lovely off-
white will make it look sophisticared. Brighe whire or solid colors will create a more fun and
Pieiting leok. Printing one design on a sampling of paper styles can make a dramatic difference
i the type of message you send.

Type styles.
Hich typestyle has its cwn unique personality. You can utilize the 300 different type faces in

Prine Artist 4.0 ro represent the message and flavor of your design. The rypefaces you select for
liwaclines and rexr affect che way a reader experiences your layour.

s

e Z;(.yzzz /@aeﬁ e forsiiarl.

Some type faces are casual.

Sothe type faces are furt arid plagful.



Some examfiles of
Brogects you can

create fn Print Avtist.
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Select New Calendar

diadug box to get

stavied.

The stepr-by-stefr process

miakes {F easy,

Tutorials

Tutorial A
Crearing a Custom Calendar
Mow that we've covered these design principles, it's time to have fun wich the thousands of

graphics, designs, fonts and special effects available in Print Artisc! Now we will apply some of
the tips and cricks

u have learned and creare a special projecr—a personalized calendar.

Choose from one of the many pre-designed calendar themes in Prine Artist, or create one
yourself! Iere's how:

Under New Calendar Categories, select Blank. You can easily change all the squares at once to
another graphic using Select All Date Graphics from the Edit menu, then Change Graphic, also
trom the Edit Menu. You can remove the texe-wire frames while you are working on your
calendar by activating them, then seleccing Cuc from the Edic menus. Put them back in by
choosing Text from the Inserc menu.

Srrecch rhe Texr window vertically ro add activities that happen on the same day each week

by selecting Vertical from the alignment window. For activiries that cover several days in a
row, strecch the text window horizontally across those days, Adjust alignment and Word Wrap
as desired.

Step-by-Step Calendar Creation

1.

der Select Document type, double-click Calendar. This brings you o the Selecr Calendar
Darte box, where

ou will see the current moneh and year, Selece any month and year between
1901 and 2099, chen click OK. This brings you to the Select Calendar dialog box.
. Select yearly or monthly Calendar.

WO

Click General Purpose in che categories list, and Abscracr 1 in the Layours list, then click
OK., Note char each “day” consists of an oval, a small text abject for the date, plus the wire
frame of a text box (which will not print). This layour also has a Diamond border.

Note: Tu see cach day more clearly, simply choose Zoow In from the View menu, o press Cted and the +
key om yosr Beyboard sntel things ave big enongh for you,



A Double-click the text frame to open the Change Text window. Type Fred and Echyl’s
Anniversary, then click the OK button. The text becomes a “note” reminding you to send
them a card (perhaps & card you made wich Print Arcisc!)

4 Double-click the text frame on che third Wednesday of the month to open the Change Text
window, Type My brocher will be visiting for these two days! and click OK, The rext
sejueezes into the one day. Use your mouse to grab the horizonrtal resizing handle on che right
slde of che frame, When your mouse pointer curns into a two-headed arrow pointing lefr and
tight, strecch the rext window to cover both days. Now vou won't accidenrtally schedule
something else during those two days.

WNute: Be sure 1o save you calendar frequently. If you change the Calendar date (month) under the Change
Catlondar Date dialog box while in progress, any wnsaved work will be lost, Neaw, you've veady to make
N ot calendar, ar simple ov complex as you'd like. You can give each day of the year it's own graphic,
Wil vach date can alto bave ity vwn block of text.

Add copry £ your
cerlendlar,
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Tutorial B:

Creacing & 1/4 fold greering card

Open a new document.

I, From the Select Document Type dialog box, click Greeting Card.
& Choose the Tall, Side-Open Card Option.

4, Choose the Blank option and click ok.

Place a fill.

|, From the insert menu or the toolbar, choose fill.

2 Using the side center resizing arrows, stretch che fill so chac all sides are expanded beyond
the border,

4, From the color menu, choose Blue 1 for the face.

/4 fold greeting cavd -
start with fills.




Place a second fill.
1. From the insert menu or the toolbar, choose fill.
.Using the corner resi

I

1g arrows and holding down che shifr key, stretch the £ill to a 2,75
square.
-Maove che fill down so that v is approximately 1 inch from the borcom.

e

- While rhe object is still selected, choose center horizontelly from the ohjece menu.
Wich che object still selecred, click thick outline from the effects menu.

[ ]

. From the color menu, choose Violet 3 for the face and Amber 2 for the face outline, °

Insert a third fill.
1. From che insert menu or the toolbar, choose fll.

2. Using side center resizing arrows, stretch fill into a rectangular shape. The width should

Tusert moon and star . i ; i i
bleed out to the border of the greeting card on both sides. The height should he

aphic ;
g"?‘p" L Elp?]’()\']mﬂrt‘]}’ 1 J.l'](_'}J.

3. Align fill ar the top border of the card.
4. From the shape menu, choose convex down.
5. Change the fill color to Violet 3.

Insert border.

L. Click the Basic Shapes butron and select Square Frame.

2. Using corner resizing arrows, expand the square frame uncil it fies around the edge in the
printable area of che card.

3. From rhe color menu, choose Blue 1 for the face.

Insert Star graphics.
L. Choose graphic...from the Insert menu or cli

% the Graphic button on the toolbar.

From the Symbols category, choose Star, 5 poine.

. Reduce the size of the star by holding down the shift key and using che corner arrows.
. With the srar seill selected, choose Duplicate from the Edit menu.
.Resizing duplicated star.

3
4
5
6

. Repeat steps 4 and 5 unril there are abour 8 srars toral. All srars should be different sizes and
they need to be randomly placed in the blue area around the vialer square.
7. Select

one star at a time o change colors. Use Amber 1, Amber 2, and Amber 3.

Change star graphic to a moon graphic.
Add rext and sun L. Selecr any one of the stars and select duplicare from che edit menu.
graphics.

b2

. Double-click the star. The select graphic dialog box opens, with the Symbols caregory, star
already selecred in the preview window. Select crescent from the symbols category to replace
the star. Double-click your se

tion.

t

. Selecr crescent and choose duplicate from the edit menu. Repeat one more time.

>

. Resize crescent to different sizes by drs
shift key.
5,5

rging the corner arrows while holding down che

ead out crescents among the srars,

6. Select all the crescents by clicking on che first one and then holding down che shife key to
select the other two.
7% ich all the 1ts selecred, choose Violer 3 from rhe color menu.




rt the sun.

asert the Sun with Face from che Proare 3 category.

ize it to be  litcle bigger than the Violet fill box in the center of the card.
Center che sun with che box,

text.

lick New Text from the menu bar.
ype Congratulations in all CAPS.
lick OK or Cerl+ to insert text.
th the type still selecred, choose Protege from the font menu.

/ith the type still selecred, click double convex from the shapes menu,

] _“se corner arrows to size the text into the Violet shape on the upper porrion of the card.
enhance the text, go ro the effects menu and select customize. Then choose block for effecc
st, lower right for variation 1 list, shallow for variation 2 list, solid for variarion 3 lise.

m the color menu, select Amber 2 for texe face and Blue 1 for sides,

= abjects inside greeting card.

ect some of the stars and crescents from the Graphics Grabber by clicking control + G.
en use the command Crrl+C ro copy.

m the View menu, choose inside right.

t, use the command Ctrl+V to paste the stars and crescents.

ect each one and arrange randomly.

or the rexr, select the text ool from the toolbar, Then type in a personal message.

ext, use the font menu to change the rext ro Protege to march the front,

size by using the corner arrows.

pen Select Document Type
rom the Selece Document Type dialog box, double click on Labels.
Select Label Category. (Choose from Avery Labels, Nebs Labels or Queblo Labels.)
croll through Layours. Select one and click OK.
hen the pre-made Label appears on the screen click an the text o change or add
o the rext,
%, When you're done inserting copy, click OK.
rint like any other document,

LANRFE ¥
<
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Place objects and text

inside greeting cavd.



Making labels with
Print Artist.

Avery Lehals
Halbs Labels
Duahlo Labels
General Purpose

LAYOU
5395 Party, Clows
5185 Party, Supplies
660 Circas

5460 Haart 1

5661 Haart 2

5661 Reladaer

i 5662 Loprachaun Hat
if 8662 flainbuw Heart
H 5662 Shameack

G663 Fastive

pkin

SELECT NEW LABEL

CATEGORIES.

Your Name
Street Address
“Clty, State Lip Code

ok | Feancer | | pEe |

When the dialog box appears for the first time, there is one blank record shown. It will be
under the text box in the lower left hand corner. Tt will be lisced as Record 1 of 1. See the
screen shot. The toclbar buttons will allow you to move between a number of labels. A similar

toolbar appears on the desktop so you can navigate as you are creacing vour labels.

Label Tools

NEW |

This button creares a new data record before the current one and moves
the record pointer to ir. The record counter will show a different roral
count, and the text entry area will be cleared to represent the new
record. The Ins key on the arrow keypad is the same as pressing this
burron,

This button will delete the current record and position the \ record
pointer to rthe previous record, or to the next record if che firse record
is being deleted. The record counter will show a different currene and
total count, and the texr entry area will show cthe content of the
previous or next record. If there is only one record, then the concents
are cleared but the record is not delered. The Del key on the arrow
keypad is the same as pressing this button, as long as there is no text
in the current record.

These buttons move the record pointer to the previous or nexe record.
The PageUp and PageDown keys on the arrow keypad are the same as
pressing these buttons.

This button moves the recard pointer o rhe first record. There is no
keyboard equivalent.

This butron meves the record pointer to the lase record. There is no
keyboard equivalent.

Noter To furere o ficr of text from another database simply copy it andd then
peiste it inte your ducrment, 'The text will automarically be added to the labels,

Refer to On-line belp for additional information.
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Troubleshooting

Troubleshooting

Common Graphics Problemns & Questions
“Premt Arrist doer not sipport some data in this graphi
Print Artist cannot work w

> stored in CMYK TIFF 24-bic. Also, TIFF
graphics of any resolucion that are stored with LZW compression cannot be read because of legal

th graphics which ar

constraints. If you try ro use these vou will ger a display of an emprty graphic wire frame.

Graphics saved in a document are gone,

The graphic you place in a document is not stored in the document. It has a marker for where the
graphic is located on your

em and places it in there when you bring the document up. If you

have changed the directory where the graphic is or have deleted it off your system, then it cannot
bring it up.

The bendle I want ir
If the handles for the graphics box are ourside of rhe main screen or hidden, then use the Zoom
Out command and this should allow you to see the handles to resize it. Ceel + W ar Zoom In
will allow you to return to the previous size view screen.

et of veach,

Maorwchrome

If you are gerting black and white ouclin > Color

Book option is not checked in the Print Oprions butten of the Prine Control Panel/Preview
screen. Also check under View to make sure Monochrome is not selected.

s of your graphics, check o make sure that th

Hewwr van I iese more than vne drive or divecrory for Print Avtise Graphics at one tin

Set up two Print Artise graphic directories by starting any new document and clicking on file,
first cwo items in the Graphics Directory are for Prine Arrist GFX
graphics. If you have GFX graphics in another directory or on a CD-ROM, change the line for
“more Print Arcist (GFX):” to lisc that cther directory or CD drive.

then an Directory Serup. Th

If you have GFX graphics in anocther directory or on a CIDD-ROM, change che line for

Print Arcise (*.GFX):” to list thac other directory or CD drive. For example???

Maore

“Too many Prine Avtise praphics” message comes up when the Graphic Grabber is intevting graphics,
Exit out of Prine Artist. Hold down the Shife and Control keys on your keyboard ac the same
time. (SHIFT and CTRL). Do nort let up on these two keys, Stare Prine Arrist again. The

Graphics Grabber will grab, add, and count all the graphics it can access on your system. Once
the Grabber is finished updating, release che Shift and Conerol keys. 1f chis does not stop the
message from appezaring, create a subdireccory on your “C” drive. Move some .GTX files from the
Print Arrise direc

tory to the new subdirecrory, Be sure to ser the Prine Arrist directory setup to
read the new location.

Wiben yow rry to import an EPS or WMF graphic fife, you ger the nesiage
“Crraphic is fon comflex o be impovied into Pring Aveist”
Scaleable graphics composed of objeces like EFS and WMF graphics cannot be imporeed if chey
are oo complex. Complexity refers to the file sice or the composition of the objeccs in the file
itself. Check che size of the problem graphic-file. If it is oo big, thereare two opeions. Eicher



» - -

wllt the praphic in a drawing program and make it smaller, or export the original graphic
{tom o drawing program in a bitmap formar such as TIF, PCX, or BMP and import the birmap
file inscead.

Wohan you export @ Print Artist Graphic GFX graphic as a WMFE graphic [ile and then try to fmpove it
bk dnto Print Arise, you veceive the message.. "G raphic is too complex to be fmported into Print Artit,”

| When Print Artist exports a scaleable graphic in che Windows Metafile (WME) format, it rmusc
Lunvert bezier curves and ellipses to the polygon and polylines used by the WMF formart. Prine
Altist also converts texr fonrs ro complete polygons. The resulting file can easily be much larger
Ul more complete than the original GFX graphic or rexr and cannoc be imported back into
Peine Artise. You can expore a scaleable WMF file from Print Arcist so it can be re-imporrted.
Weduce che size of the original GFX graphic so it is smaller on the Print Artisc page BEFORE
yuu expore the file. if you want to exporr several Princ Artist graphics to be used rogether in a
Mtgle composition, try exporting them separately. The last aprion is to expore the original GFX
prnphic as a TIF or BMP file instead.

Print Artise Graphics divectory setup taber too long to wpdare.

Prine Artist provides GFX graphics in two locations, vet it only allows the user to sct path
iccess for only one of those third party sources at a rime. Switchi ng berween third party sources
Ih extremely inconvenient, confusing, and time consuming. The Graphics Grabber rebuilds the
Jinphics database each rime users switch graphic sources or change the number of graphics.
This update process takes minutes on fast machines and more than half an hour on 2 slow 486,
The problem compounds if the user upgrades from an older version or if the user buys
wdldlitional Prine Arcist Graphics CDs from the User Club. Due to these conditions, there is no
snlution to speed up this process.

Lo Giraphici Grabber dialog box is too big for the screen. Opening boxer may alio be trancated,

This usually happens wich alternate Windows deskrops like Norton Desktops, Dashboard,
Nuvigator or Tabworks. Disabling the desktop and using Program Manager instead should
torrece che problem. If chis does not help, then the Windows system fonts have been
uverwricten or deleted. Reinsrall the Windows fonts from your original Windows diskerees to
torrect chis,

Vou veceive o Graphics Grabber update failure or an installation failure,
This is cavsed by not encugh vircual memory in Windows 3.1. Follow these steps to access and
thiange the Windows swap file:

1. Close all Windows applications.
4 Open the “Main” folder on your Windows desktop.
4, Double-click on the “Contraol Panel” icon.
4 Double-click on the “386 Enhanced” icon.
9. Click on the “Vircual Memory..."” button.
0. Click on the “Change = =" button.
/i Type 12 000" in the “New Size” selection box, under che "New Sertings” heading.
H. Select “Permanenc” from the “Type” pull down combination box, if it is available. If
"Permanent” is noe available, select “Temporary.”
OUIF “32-bit File Access” is checked, uncheck it. This should remain turned off. If you have a
"32-bir Disk Access” oprion, leave it checked.
10, Click the “OK" buttan.
11, Click the “Restart Now” burton.




Windows will restarc and rake you back to the main Windows desktop. This procedure should
correct the Princ Artist errors,

Print Aviist locks wp while the Graphic
Make sure that the Directory Secup for Print Artist Graphics is pointing to the correct directory
and subdirectory to find your additional graphics. Additionally, if you are using a Cirrus Logic

r Grratbber s vanning.

VLB video card, change your Windows video driver to the SVGA 2506 color driver for Windows
3.11. If you are using Windows 93, check with your video card manufacrurer for rhe correce
updated video driver. We recommend running Windows in 16 million colors. Be sure ro check
your video card manufacturer documentation fefore changing your Windows serrings.

Common Printer Problems and Questions

Wohat printers work with Pring Avtist for Windows?

Print Arcist will work with any graphics printer driver installed in Windows (including plotter
drivers). Occasionally, the printer manufacturer’s most recent driver may be needed for best
printing performance. Print Artist cannot work wich the old “daisy wheel” princers, princers
that cannot print graphics, or some industrial outpur devices like stencil cucrers.

The colors on the Print Artisi sereen look diffevent when printed on paper.

This occurs because che colors on che Pring Arrist program screen are “transmitted” colors using
the monitor as the only light source, while printed colors are reflected off che paper and use the
pigments in the ink and room light for viewing. To adjuse for this, most prinver drivers allow
vou to lighten or darken the overall printout with controls in the Concrol panel’s Printer setup.
You can print the sample palette from the Princ Artise using your color printer, and use the
printed paletee as a reference sheet when you selece colors. Then, check rhe settings for your
printer in the Windows Control Panel. There may be a slider contrel to adjust for lighter or
darker output. Adjusc chis densicy and prine che swarch again, adjusting and printing until you
get the colors you want. Comparing the palecee wicth Prine Artist’s sample pelette will help you
make accurate color adjustments.

Givesting caveds da not fit on the page covvectly.

Greeting card adjustment is a balance of starting at the correct position and adjusting the
outpur size. the upper lefr corner of the printout is fixed by secting the top and left margins,
Adjust the percent output size so che top and left marging are smaller than che righr and
botrom margins. Increase

e top or left margins ro shift the overall image until the opposire
margins are even, if you need to enlarge the overall output, reduce the rop and lefe margins
first, and then increase the percentage size. After princing, you may want ro reser the pring
area values to their defaules. Go to the Serup in the Print Arcist Print Control Panel. Select

your printer driver, Click on OK and go to Print Options/Configuracion and resec M
Symmetrical. When you click on the OK, che Percent size should reser irself.

Argins o

Print Avtist taker several minutes longer 1o pring each page than your word processor does.

This is normal for graphics printing. Depending on your printer type, between 150 KB and 4
MB of infarmation may be sent to your printer for each black and white page princed in
graphics mode. Each color page printed requires 2 to 5 times more informartion. In addition,
00 DPI {(dots per inch) printing requires four times as much information chan 300 DPI
printing. It can take many minuces to send a full page of information to the printer ac 600
DPI.




BNE A rtist takes donger than balf an bour to privt each page.

temely long graphics prine rimes can occur if Windows 3.1 is not using memory efficiently.
the Help menu in Program Manager and click on “About Program Menager,” Make sure

| Windows is running in 386 Enhanced Mode and thac it has at least 8 MB of memory

le. If these sertings check our, try the following steps:

off the Windows Princ Manager.

ke sure you have ac least 10 MB of free hard drive space.

ou have DOS 6.0 or above, rua the DOS DEFRAG utility o fix fragmented program files
free up lacge blocks of hard disk space.

k the Windows rask lise to see if anything else is active in Windows. To do this, hold
the CONTROL key (CTRL) and the ESCAPE key (ESC) at the same time. If anything
than Program Manager is listed there, highlight and click once on the Program name,
click once on END TASK. Do chis for all programs uncil only Program Manager

1ins.

date your printer driver from your printer manufacturer.

these steps make no difference in prine rimes, please call Sierra Technical Suppore while
e at your computer so we can help you examine your compurer system further.

W tword processor printr sharper text characters than Print Avtict duer,

finters run in eicher character mode or graphics mode. Characeer mode is similar to rypewriter
ﬁng. It uses solid color text and fixed font sizes for maximum sharpness and speed. By

rase, Print Artist uses graphics mode printing for grearer custom control and color SUPPOrE.
Arcist creates the original page in your compucer and sends it to your printer in rows’or

w of information. Your printer duplicates the strips of informarion as dot patterns that look
Lext or picrures on paper. Wich Print Arrist, text can print ar any size in any position ac
Jngle, not juse line by line. The sharpness of specially designed fixed fonts is sacrificed for
icise control and the freedom of customized layour.

¥ dot maiviz privver. the primted page bas thick borizontal gaps ar thongh

vinter ondy printed every ather fine,

ose a differenc printer driver. This usually oceurs when a 24 pin printer driver is used with a
in princer, or when a color driver is used with 2 black and whice princer. Check your printer
nnual for the name of the correct driver of a “comparible” princer driver.

Wl ASCIT texcs characters appear vandonily with the vegular graphics printing on the page.

‘occurs when information being sent to the printer becomes corrupred. The most likely
‘of this corruprion is a bad or intermiceent printer cable connection. Many printer cables
© 24 pin connectors but only 9 or 13 acrual wires runni ng through the cable. This works

¢ for most text printing and graphic font printing, however, if your printer supports
handshaking” communication between the printer and the program, then a full 24 wire

) "ll'nt'er cable may be necessary for graphics printing.

Il you already have a 24 pin cable, try disabling Print Manager. You should also make sure char
10 print switching device is attached ro the printer cable. Boch electronic and mechanical
wwitches can cause problems with graphics princing,

|



Lach printed line on your document bas a white bairline gap.

If you have a dot matrix printer, you may need a new ribbon, or you may need to increase
platen pressure on the print head. If you are using a tracror feed, you can often eliminate this
problem by using friction feed {or vice versa). if you have a deskjer or bubblejet princer, you
may be running low on ink, or one of the holes in the print head may be clogged. Check your
printer manual for the correct maintenance procedures.

You printer prints a few lines at the top of the page and either staps or efects the paper.

This aceurs when the communication “handshaking” between the program and the printer
breaks down. This can be caused by using the wrong prinrer driver, a bad printer cable, or the
use of a print swiccher. Since rext printing does not require handshaking and graphics printing
does, problems of this type can exist for a long time, but not show up until a program like
Print Artist is used for printing. You should bypass any prine switchers and try a new or
different princer cable. You should also make sure chat the printer cable has 24 wires in the
cable.

Your colar dot matrix printer will not pring in draft mode. 1t prints a fow lines

of gavbage and Jocks up the compurer.

Since most color dor marrix printers cannot print in draft mode, use the high quality maode
instead. Also, make sure your princer driver can support the micro-linefeeds used for color
graphics printing, and that your printer cable has all 24 wires.

Your laser printer prints balf the sign on one page and the other half on a second page.

Oy, you get @ print overvan ervor Message.

Both of these are printer memory problems. When the printer’s memory fills up, it will print
only part of a page at a time. To test for a memory problem, reprint the page at 150 DPL If the
full page prints, you may need to add more memory co your printer. This problem could also
occur if the printer memory is filled with downloaded fonts. Restarting rhe printer to clear ics
memory of the fonts should solve the problem. When you receive a print overrun message, {irse,
make sure chat there are no other active programs running in Windows, including screen savers,
reminder programs, and Print Manager. Then, rurn on Page Protection in Windows Printer
Setup. Make sure your prinrer setup correctly idencifics how much memory your printer
conrains. Finally, contact the printer manufacturer to ensure that your printer driver is the lacest
Windows printer driver available,

Why is rhe Percent Size setting not 10092 Should I adjnst it?
Print Artist allows you to print your work on any printer supporred by Windows, and

calculates how a page should be arranged, seering chis as its base. Your printer is then compared
to this base. This means the default Percent Size setting for your printer will mose likely be
herween 90% and 110%. Changing chis percencage may lead to princing problems. If you have
more than one printer hooked up to your computer, Print Arcise will adjuse the Percent Size

accordingly if you change printers.

Print Avea Settings.

This funcrion allows you to make minor adjustments. It is recommended to use the default
sectings, however, this does allow you another option in seccing the prine area. Keep in mind
that your princer has presec areas that will not allow you to print on them. For these
measurements, check your printer documentation. The Prine Arcist Test will show you the
allowable size area in which you can princ. Even if you adjust the Margin Sertings, chis area will
not change. This is the area in which your printer will not allow you to print.



Hing vards have a large top margin.
k your printer documentation for information on disabling Automaric Paper
alvincement. Also, check to make sure you'are using the most current printer driver.

WL printing banners, you have large gaps or you get 112 inch sections

are dosbie-prinied on each printed page.

18 perforacion skipping, and can be overcome on many dot marrix printers by changing
ngs in Prine Artist Printer Control. For most dot matrix printers, change the following
nis: Under Print Area, make sure no items are checked. Under Prine Options, make sure
Margins are ser to Minimal, Rotation ser to Automartic, and chat no miscellaneous items

Cmnrked. If these settings are not enough, under Prine Secup, choose Cur Sheer on Tracror in
I8 Paper Source area,

wper will ot print coveectly on your Derkiop printer

west resules, keep your paper size ser o Letter instead of Envelope in the Windows Conrrol
¢l This will give you greater flexibility to position the letrer in rhe printer. In the

it Artist Printer Conerol Panel, use the Print Options to set rotation to Never or Always
nding on the orienracion you need. Adjust the percent output size so that the image fics
[ortably on a single sheet of paper. If necessary, use your mouse to drag the image area

the left, center, or right posirions to match your princer’s envelope feed. Try a tesc print on

nvelope and adjuse the percent size again to allow the print area to be as large as needed
the envelope.

vinter works fust fine with all my Windows programs except Print Artist. .

t Artise and the Windows Paintbrush program print graphics in exactly the same way, s

can use Windows Paintbrush to verify your Windows Graphics Princer Secup. Starc

ntbrush by double-clicking che Paintbrush icon (usually located in the accessories group).
a Picture and try to print it. If it does not print, then you may need to reinsall rhe

ers for your printer or contacr your printer manufacturer for an updated driver. If it prints

y then try reinssalling the Prine Artise program. Pay parcicular attention to Windows

mory ({looking for 8 MB or more) and make sure other programs, such as screen savers or

s protection, are not running in the background during inscallation.

* ( cannot print mdtiple copies while wsing a Canon BJC GO0,

Ihe most common Windows 3.1 printer driver for the Canon BJC 600 has & problem thac

“l ents it from printing more than one copy of a graphics page at a time, To bypass the
Jroblem, exit Princ Artist. Go to the Main group and open Control Panel. Open princers and
0ose secup for the Cannon BJC 600. Change Media Type from Plain Paper ro Other paper.
lick on OK and close the Contral Panel. Prine Arcise should then prine correctly. You may also
wint to call the princer manufaceurer and gee the latest Windows printer drivers.




To Use This Graphics Catalog

Ie lmages in chis catalog can be found in Print Artist by using the Graphics Grabber. To find an image you like,
y enter the caregory name in the Graphics Grabber, then locace che specific graphic name.

Jue to scheduling difficulcies and lasc second changes there is possibility that some graphics listed in chis catalog
t be in the final version of Prine Arrisc.
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Fonts_

1. 22 Font Install:
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3. 300 Font Install. In addition to the 22 base fonts and the 150 fonts, these include:
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CUSTOMER SERVICES

Customer Service / Technical Support and ‘Fax-back’ service

Tel: (0118) 920 9111
Fax: (0118) 987 5603

Lines open 24 hrs, 365 days a year, using
our automated technical support attendant.
This system includes answers to all
commonly posed questions and problems
with our new and major titles. It is set up in
a friendly and easy to use menu system that
you navigate through using a touch tone
telephone, This service will also allow yvou

to automatically receive by fax technical
troublesheoting documents about the
games you are having trouble with, even in
the middle of the night! If the answer to
your question is not in our automated
system, then you will be transferred to a
technician between the hours of 9am and
Spm Monday to Friday.

Here are some key-presses that will allow you to navigate through our automated atten-
dant. Note that these are the standard letter assignments that are given to UK telephones

s0 if your phone has letters on the keypad, please use them instead:

o G e s .

2

Before you call our technical support lines, please check that you have read the
Readme file included on the game disk #1. You may well find a very quick answer to
the problem that you are facing as these files contain answers to most common
preblems. If the answer is not here, make sure you have precise details of any error
message that you receive, and details regarding the specifications of your computer
before you call us, as this will help us in giving you a faster and more efficient service.

If you would prefer to write to us, please send your mail to the following

address:

SIERRA ON-LINE LTD

Customer Services / Mail Order / Tech Support Department
2 Beacontree Plaza
Gillette Way
Reading * Berkshire
RG2 0BS
United Kingdom




Sierra UK Web site

http://www.sierra-online.co.uk
UK Website includes technical support, mail order, chat rooms, product informa-
tion, game demos and much, much more.

New Hintline (UK callers only)

(0891) 660 660

24 hrs. Automated service requires a touch tone phone. Calls cost 45p/min. cheap
rate and 50p/min, at other times. Max call length 7.5 minutes. Max call charge at
cheap rale £3.38, £3.75 at other times.

Older Games Hintline

(0118) 9304 004

24 hrs. Automated service requires a touch tone telephone.
Calls charged at normal telephone rates.

IMPLIED WARRANTIES LIMITED: SIERRA MAKES NO WARRANTY, EXPRESS OR
IMPLIED, REGARDING THIS PRODUCT. SIERRA DISCLAIMS ANY WARRANTY
THAT THE SOFTWARE 1S FIT FOR A PARTICULAR PURPOSE, AND ANY IMPLIED
WARRANTY OF MERCHANTABILITY IS EXPRESSLY AND SPECIFICALLY
DISCLAIMED, SOME STATES OR COUNTRIES DO NOT ALLOW LIMITATIONS ON
WARRANTY, SO THE ABOVE LIMATION MAY NOT APPLY TO YOU.

NO CONSEQUENTIAL DAMAGES: SIERRA SHALL NOT BE LIABLE FOR SPECIAL.,
INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF SIERRA IS
ADVISED OF OR AWARE OF THE POSSIBILITY OF SUCH DAMAGES. THIS MEANS
THAT SIERRA SHALIL. NOT BE RESPONSIBLE OR LIABLE FOR LOST PROFITS OR
REVENUES, OR FOR DAMAGES OR COSTS INCURRED AS A RESULT OF LOSS OF
TIME, DATA OR USE OF THE SOFTWARE, OR FROM ANY OTHER CAUSE EXCEPT
THE ACTUAL COST OF THE PRODUCT. IN NO EVENT SHALL SIERRA’S LIABILITY
EXCEED THE PURCHASE PRICE OF THIS PRODUCT. SOME STATES OR COUNTRIES
DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY
NOT APPLY TO YOU.

You are entitled to use this product for your own use, but may not sell or transfer
reproductions of the software manual or book te other parties in any way, nor rent or
lease the product to others. You may use one copy of the product on a single
terminal connected to a single computer. You may not network the product or
otherwise install it on more than one computer or computer terminal at the same
time.
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